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1 JustLanded for WordPress
Thank you for purchasing JustLanded, the ultimate landing page package designed to provide you
with all the building blocks required to sell a product online – within minutes.  

We took our  successful  JustLanded template  and turned it  into  a  WordPress  theme,  added a
Landing Page builder tool and all the features you would expect from a WordPress theme.

JustLanded has been designed with ease of use in mind. You can use the demo data we provide
with the installation package as a starting point for your own creations, and just play around – or
you can follow the outline of  this  manual  from top to bottom. Most features  should be self-
explanatory,  but some more advanced features may require you to actually read up on them first.

Whether  you  are  a  WordPress  veteran  or  an  absolute  beginner,  this  manual  will  act  as  your
reference guide.

1.1 User Interface

Please note that we do not provide customer support through the themeforest comments section to ensure 
the best possible quality of service and to keep track of all issues. We love to help, and we do so quickly – 
so if you require any assistance setting up or customizing JustLanded, please send an email to

 support@shapingrain.com 
where we will acknowledge your request and strive to attend to it as soon as possible.

Please note that we do not provide customer support through the themeforest comments section to ensure 
the best possible quality of service and to keep track of all issues. We love to help, and we do so quickly – 
so if you require any assistance setting up or customizing JustLanded, please send an email to

 support@shapingrain.com 
where we will acknowledge your request and strive to attend to it as soon as possible.

mailto:support@shapingrain.com
mailto:support@shapingrain.com


JustLanded for WordPress uses a tabbed user interface to provide easy access to all its features.  

Some basic principles:

• The most important or most commonly used menu items are at the top.

• Some menu items contain sub menus that will only become visible once the parent menu
item has been activated. 

• Hints that provide basic in-context help are shown either next to each option or next to an
option's headline. All hints and help boxes can be hidden by clicking on the "?" icon at the
very top.

This manual basically follows the tab menu from top to bottom. In order to access the JustLanded
for WordPress user interface or options panel, click on the “Theme Options” button  next to the
WordPress icon in the admin bar at the very top of the screen, or navigate to Appearance →
Theme Options.

1.2 Updates

With your purchase of JustLanded for WordPress you have lifetime access to free upgrades.

JustLanded for  WordPress  includes  an  update  checker.  It  should  alert  you  to  official  updates.
However, in some cases that update option may not work properly due to server restrictions or
while our servers are unavailable. You should therefore regularly check our customer interface or
the  themeforest website  for  updates  and  keep  both  your  WordPress  installation  as  well  as
JustLanded for WordPress up to date to avoid security issues or incompatibilities.

You should always back up your JustLanded for WordPress options, your WordPress database
and your WordPress directory before upgrading JustLanded for WordPress or WordPress itself.

And please remember that during an update all custom files placed in the theme folder will be
deleted, and this includes translations saved in languages folder.

Please read these instructions carefully if you are already using JustLanded for WordPress and are about to 
upgrade to a new version.
Please read these instructions carefully if you are already using JustLanded for WordPress and are about to 
upgrade to a new version.

NoteNote

To prevent inadvertently overwriting your settings, please make sure that only one instance of the options 
panel is open at any time. Do not open multiple instances in tabs, as this might lead to your settings being 
written into a wrong settings profile.

To prevent inadvertently overwriting your settings, please make sure that only one instance of the options 
panel is open at any time. Do not open multiple instances in tabs, as this might lead to your settings being 
written into a wrong settings profile.



Automatic Installation using the WordPress Interface

Whenever the update checker finds an update, you will have the option to update your installation
of  JustLanded  for  WordPress  using  WordPress'  built-in  update  tool.  Access  to  this  automatic
update feature is available only to registered customers with a valid license key obtained from the
customer interface on ShapingRain.com. If you do not have an account yet, please register for a
free account at http://ssl.shapingrain.com/register and verify your license.

The automatic update feature will put your blog into maintenance mode, deactivate the theme,
remove the old theme folder, install the new one and re-activate the theme.  Your settings and
contents will be preserved during the update.

Manual Installation using the WordPress Interface

Please note that when using the WordPress interface to update your copy, all existing files in the
theme directory will be deleted. Settings and contents will be preserved.

1. Go to Home -> Backup and Import -> Master Export File -> Download to download a backup
of your settings. This Master Export File contains a copy of all your settings profiles and
support can help you restore this in case anything goes wrong.

2. Go to “Appearance” in your WordPress admin panel and activate another theme. This can
be any theme, and the only purpose of this step is to free the theme so it can be deleted.

3. Click on "Delete" for JustLanded for WordPress and confirm that you wish to delete the
theme. This is safe as all your settings will have been saved in the database rather than the

The automatic update feature was introduced in version 1.2.0 of the JustLanded for WordPress theme. If you 
are currently using a lower version, this feature will not be available and you will have to perform a manual 
update. The next update will then be delivered through the automatic update feature.

The automatic update feature was introduced in version 1.2.0 of the JustLanded for WordPress theme. If you 
are currently using a lower version, this feature will not be available and you will have to perform a manual 
update. The next update will then be delivered through the automatic update feature.

Registration and license activation is a voluntary process required only if you want to receive automatic 
updates and use the one-click update feature. You can still receive update notifications and update your 
theme manually, even without a license key.

Registration and license activation is a voluntary process required only if you want to receive automatic 
updates and use the one-click update feature. You can still receive update notifications and update your 
theme manually, even without a license key.

http://ssl.shapingrain.com/register


theme folder. But remember to keep a backup of any core files you have edited.

4. Install the zip file, as you would for a new installation.

5. Activate JustLanded for WordPress again.

Don't worry, this will still not remove your existing contents and your settings will be preserved.

Using FTP/SSH access

Follow the same steps as you would for the first installation. Make sure you double-check that you
have a copy of all customizations applied to the theme's core files.

You could delete the existing copy first prior to copying the new files as the theme does not save
settings into the theme folder. Just copy the 'justlanded' folder contained in 'justlanded.zip' into
the wp-content/themes directory. Settings and contents will be preserved.

Post-Update Steps

Update 1.0.1 → 1.1.0

Version 1.1.0 is the first one to be fully responsive. If you are currently using video clips via embed
codes,  please  make  sure  that  you  convert  these  into  simple  video  links  as  this  version  of
JustLanded uses WordPress' own oEmbed mechanism to easily insert video clips. The new method
also ensures that generated embed codes are actually compatible with the new responsive layout.

We have added a variety of new features, some of them clearly visible, others hidden 'behind the
scenes' – make sure you study the highlighted sections of the manual as these indicate updates or
additions.

50 new features, enhancements and bug fixes have made it into the update. If you are unsure how
they affect customizations applied to your installation by support staff, please contact support and
seek clarification. We have access to your support tickets and can verify what impact the update
may have on your installation of JustLanded for WordPress.

Update 1.1.x → 1.1.5

If  you are using Page Content Blocks that contain only Landing Page Blocks as shortcodes,  we
recommend that you use a new option to 'not wrap page content block in separate section tag',
which will correct problems in earlier versions in this use scenario.

Update 1.1.x → 1.2.0, 1.2.x

No particular steps are necessary for this update.

Update 1.2.x → 1.3.x, 1.3.x → 1.4.x or 1.5.x



No particular steps are necessary for this update. New features have been added with this releases
and it really is necessary that you perform a complete update rather than copying only parts of the
new version, in order for all of those to work properly.

2 First Steps

Let's walk you through the first steps of getting JustLanded for WordPress up and running. It should
only take minutes for you to get a landing page set up since JustLanded for WordPress comes with
building blocks. You don't have to think much about layout and design. Just like a house built with
prefabricated  blocks,  in  JustLanded  for  WordPress  all  you  need  to  do  is  to  put  those  blocks
together. In a next step you add your contents – or in some cases, simply fill in the blanks. It's that
easy!

2.1 Install WordPress

For  this  manual  we assume that  you already  have  WordPress  up  and  running.  Many  hosting
providers offer one-click script installers, but setting up WordPress is very straightforward even if
yours doesn't. WordPress calls it the "Famous 5-Minute Install".

If this is the first time you are installing WordPress, make sure you read the excellent tutorial put
together by the WordPress team: http://codex.wordpress.org/Installing_WordPress

We recommend that you install the latest version of WordPress. At the time of writing this manual
this was WordPress 3.6 – the latest version JustLanded for WordPress was tested with. 

We have not tested JustLanded for WordPress with any version prior to 3.6.

2.2 Install JustLanded

JustLanded for WordPress ships as an installable ZIP archive. There are two options for installing a
theme in WordPress:

Upload the installable ZIP file

The actual theme installation archive is called justlanded.zip – this file is included in the main file,
or directly downloadable from themeforest as 'Installable WordPress file only'. 

We highly recommend that you read this section even if some of these steps may seem familiar to you. 
They contain instructions for first-time users, but may also be of interest to experienced WordPress users who 
never had to set up a landing page before.

We highly recommend that you read this section even if some of these steps may seem familiar to you. 
They contain instructions for first-time users, but may also be of interest to experienced WordPress users who 
never had to set up a landing page before.

NoteNote

Please refer to the Updates section if you are updating an existing installation of JustLanded for WordPress.Please refer to the Updates section if you are updating an existing installation of JustLanded for WordPress.



Do not attempt to upload the main  file as you downloaded it from themeforest  (“All files and
documentation”) – this will fail as it is not a theme (WordPress does not know what to do with
it) and likely too large for your upload limits.

Downloading  the  installable  WordPress  file
directly from themeforest (“Downloads” page) is
the safest way of making sure that you are indeed
uploaded to WordPress what it expects.

Uploading the installable zip file most convenient way, but it only works if your web server has
permission to write into the wp-content/themes folder.  Navigate to Appearance → Themes →
Install Themes and click on the Upload link. Click "Choose File" and find the installable ZIP file on
your computer.  Once you click "Install  Now",  your browser will  upload that file  to WordPress,
which will proceed to copy its contents into the wp-content/themes folder.

Then, locate JustLanded in your themes (Appearance → Themes, you really can't miss it) and click
on the "Activate" link if you haven't done so already during the installation.

If the installation fails, it is probably because of wrong file permissions.

Upload the theme to the wp-content/themes folder

If the ZIP file method doesn't work, fear not! Simply unzip the "justlanded" folder contained in the
ZIP file and upload its contents to the wp-contents/themes folder of your WordPress installation.

Then,  locate  JustLanded  in  your  available  themes  (Appearance  →  Themes)  and  click  on  the
"Activate" link if you haven't done so already during the installation.

Both methods are also described in detail at http://codex.wordpress.org/Using_Themes.

2.3 Setting up WordPress for use with JustLanded

Permalinks

You may also call them 'pretty links', as with permalinks activated, links generated by WordPress
will be much easier to read, and more accessible for search engines. We highly recommend that
you do activate either one of the link structures under Settings → Permalinks → 'Common Settings'
and you can read up on the permalink settings at http://codex.wordpress.org/Using_Permalinks

Landing Page

You may skip this step if your intention is to import the demo data that ships with JustLanded for WordPress
as the import will automatically create posts and pages.

Your Landing Page will only be displayed on pages using the "Landing Page" template. In order to
turn a WordPress page into a JustLanded for WordPress landing page, simply change the page



template to "Landing Page" under "Page Attributes", a block that by default is located right of the
text editor.

If  this  is  a  fresh  installation,  you  may  want  to  create  a  new  page  first.  Navigate  to  
Pages → Add New, enter a title (e.g. "Landing Page"), and select the "Landing Page" template (Page
Attributes → Template, on the right hand side).

Use a landing page as your front page

If you want this to be your default page, you will have to navigate to Settings → Reading and select
"A static page" under "Front page displays", and choose your newly created page under "Front
page".

Blog

If you would like to designate any other page to be the blog index page, follow the steps for setting
a static landing page and select your desired page as "Posts page" under the "Front page displays"
section. You may have to create a blank page for this purpose first if this is a new installation and
you are not using the demo data. Otherwise select the "Blog" page that was created when you
imported the demo data.



2.4 Demo Content

You do not have to use the demo data we ship with JustLanded for WordPress at all. However, it
may serve as a good starting point and all demo data can easily be reset and deleted at any time.
Keep in mind, however, that installing demo data may overwrite existing posts, pages and settings
– so if your WordPress installation already contains contents, make sure you back up your existing
settings first.

The demo import consists of two steps, and you can opt not to perform one of them. 

If you would like to import demo options for different landing page styles only, but not have your
installation 'polluted'  with demo posts and pages,  you can skip the XML import.  In  that case,
however, you will have to assign the 'Landing Page' template to a new, empty page, in order to
actually see the demo data. And as without the XML import no pages are imported, some of the
demo content – Page Content Blocks – will be hidden.

Step 1: XML Import (Pages & Posts)

With JustLanded for WordPress we provide an XML export of our demo installation that contains
sample posts and pages to show off most of the theme's features. You may as well decide not to
use this file at all, but it might be a good starting point and help you learn how JustLanded for
WordPress works.

In order to import the XML file, navigate to Tools → Import in your blog's admin panel. Select
"WordPress"  from  the  list  of  available  import  tools,  then  click  "Choose  File"  and  select
JustLanded_for_WordPress_Demo.xml, which is located in the 'justlanded' folder within the ZIP
file. Then click on the "Upload file and import" button to begin the import process.

If there is no "WordPress" option under "Import", you may have to install a plug-in provided by the
WordPress team. If this is the case, WordPress will prompt you to do so.

If you would like to make any landing page your front page or change your blog index page, please refer to 
http://codex.wordpress.org/Creating_a_Static_Front_Page  for instructions how to do this with WordPress.
For our public demo site we have used 'Landing Page' as the 'Front page', and 'Blog' as the 'Posts page'.

If you would like to make any landing page your front page or change your blog index page, please refer to 
http://codex.wordpress.org/Creating_a_Static_Front_Page  for instructions how to do this with WordPress.
For our public demo site we have used 'Landing Page' as the 'Front page', and 'Blog' as the 'Posts page'.

http://codex.wordpress.org/Creating_a_Static_Front_Page
http://codex.wordpress.org/Creating_a_Static_Front_Page


During the import process you will be asked to map users. For each demo user in the export file
you may choose to map an existing user on the blog, or to create a new user. Imported posts and
pages will appear as if they had been created by the mapped user.

Once the import has finished, you will find several new pages and posts with demo content that
you may wish to delete at a later time. Deleting demo data from your posts and pages will not
affect JustLanded for WordPress, and any settings made within the JustLanded for WordPress user
interface will not be affected.

Do not be alarmed by error messages or notices informing you about parts of the import that were
not  successfully  completed. This  may simply indicate that you were missing a plug-in that  we
provided demo content for. 

Step 2: JustLanded Profile with Demo Contents and Settings

Open  the  JustLanded  user  interface  by  clicking  on  the  paper  plane  icon  located  next  to  the
WordPress icon in your admin bar, or navigate to Appearance → Theme Options. From there click
on "Backup and Import", the first tab under "Home". Click on "Import Demo Data". You will be
prompted to confirm this step. Be aware that existing settings of JustLanded for WordPress will be
overwritten if you proceed.

That's it! You should now have a variety of options pre-set to demo the JustLanded for WordPress
experience.

The XML file only contains posts and pages created with WordPress. In order to also import contents and 
settings for JustLanded for WordPress, you will have to import these settings as well.
The XML file only contains posts and pages created with WordPress. In order to also import contents and 
settings for JustLanded for WordPress, you will have to import these settings as well.

Please remember that by default the theme will have no menus set for the header and footer navigation.  
The import contains demo menus that link to all the demo pages, but you will have to activate these 
manually. Head to "Appearance → Menus" and select the main and footer menus from "Theme locations" 
before saving your settings with "Save".

Please remember that by default the theme will have no menus set for the header and footer navigation.  
The import contains demo menus that link to all the demo pages, but you will have to activate these 
manually. Head to "Appearance → Menus" and select the main and footer menus from "Theme locations" 
before saving your settings with "Save".



2.5 Your First Landing Page

For this chapter we assume that you have opted to install the demo data that ships with JustLanded for 
WordPress. In order to follow this quick tutorial without the demo data, you will have to create a WordPress 
page and select the "Landing Page" template for that page in order to view your results.

Once you have imported the demo data, you are basically ready to go. You now have a landing
page and a blog, and they both look stunning. Now what? 
Well, since JustLanded for WordPress is designed mainly to be used as a landing page to sell a
product, let's assume that this is what you care about most – the landing page. This is where you
will direct all your traffic to, it will be the first thing your visitors will see.

When we designed JustLanded for WordPress we looked at popular, well-performing landing pages
and developed basic building blocks that, when put together, result in a landing page that simply
works. The intention was to create a landing page building package that enables a first-time user to
create a converting landing page within minutes, while giving more experienced marketers the
possibility to do with our product pretty much whatever they want.

So let's look at the most prominent features and find out how you can adapt them to meet your
requirements. 



Layout

The  most  obvious  first  thing  to  do  is  to
decide what content to use on your landing
page, and where to put it. Since our landing
page  is  based on  easy-to-use  blocks,  let's
disable some of the demo blocks and start
with a basic landing page.

Both the selection of blocks as well as their
position can be defined using the "Landing
Page Layout" tool. Open the JustLanded for
WordPress user interface by clicking on the
paper  plane  icon   (or  navigate  to
Appearance → Theme Options), then select
the "Landing Layout" tab.

By default, quite a few blocks are active and
already contain  some content.  JustLanded
has  one  very  prominent  block  that  is
enabled by default – the banner. Everything
else is optional, and for the purpose of this
demonstration we won't need most of the
demo blocks. 

Let's  quickly  disable  all  blocks  except  for
"List  of Features" and "Payment Options".
Disabling a block is easy, just drag & drop
the  block  you  want  to  disable  from  the
"Enabled"  section  over  to  the  "Disabled"
section. When you are done, only the "List
of Features" and "Payment Options" blocks should remain enabled. It is a good idea to save your
settings regularly while editing your landing page, so go ahead and click on the green "Save All
Changes" button.



Banner

The banner is a main feature of every landing page you create with JustLanded for WordPress, it is
where you introduce your product and give a potential customer the first opportunity to buy your
product.

This block consists of a text content and a media content section, both of which can be defined
through the JustLanded for WordPress user interface. To make changes to the banner, activate the
"Banner" tab. 

By default, media content is shown on the right hand side, while text content and the headline are
displayed on the left hand side. This arrangement is fine for the moment, so let's move on to the
Banner Title section.

Banner Title

The main title will likely be one of the first elements a potential customer will see, so every word
counts.  Focus  on the benefits,  tell  your customers what  is  on offer,  let  them know how your
product will contribute to their lives and fulfill their desires. Think about who you are selling to.
Who are your potential customers, and what are they looking for?

"Lose Weight in 3 Weeks Without Working Out" works well for a diet product, "Learn to Speak
Spanish" might well be enough to sell a Spanish course.

For emphasis you can break the headline into two or more lines. While editing the headline, just
hit ENTER where you want to break the headline.

Banner Text

The text field below contains text that goes underneath the main headline. Pick up your product's
main benefit here and talk to your customer. Treat this just like an extension of your headline,
illustrate how your product meets your customer's desires. Don't write too much, keep it simple.



Banner Bullet Points

Your customers want to be convinced, and nothing works better here than a few simple bullet
points. Ideally you should treat your landing page as if you were having a conversation with your
customer, so continue the message, list some more benefits, tell him what's so special about your
product.

Enter one bullet point per line – JustLanded for WordPress will turn each line into a beautifully
styled bullet point. 

Media Content

You've heard this many times before, but it's true: an image says more than a thousand words.
With JustLanded for WordPress you have the choice to display a single image, an image slider or a
video clip next to your text content and main headline. If you like, you can also include any kind of
free form content.

Why not start with a simple image here? A product shot perhaps, the picture of a happy customer?
Under "Select Media Content", select "Single Image" if that option is not already selected. Then
click the "Upload" button under "Single Image", locate an image file on your computer and upload
it to WordPress.

Action Buttons

The next important thing is the action buttons block. You can have a single big action button, or a
set of two buttons. If you are giving away a free sample, you could have a single button "Get a free
sample", and if you are selling a product, you might want one button saying "Buy for $10", and
another one that says "Contact us". 

Select a button style and simply enter your button's caption and a URL for this button to link to,
then save your changes and you are done. 

The action buttons you define here will be used for both the banner and the Payment Options
block.

List of Features



We selected the List of Features block to explain how most landing page blocks work. It is also a 
very powerful tool to show off your product's benefits. So let's get started right away...

Headline and Sub Headline

Have a quick look at this block's options and activate the "Feature List" tab.

Most  landing  page  blocks  have  a  headline  and  a  sub  headline.  Each  headline  gives  you  the
opportunity to highlight certain aspects of your product, and to continue the conversation. 

We recommend that you use at least the main headline. This block is ideal to show off product
highlights, so why not introduce them with a catchy headline? "6 Reasons why buying this product
will change your life", or pick up the main headline's promise and continue that message.

Feature Items

For many landing page blocks we use a multi-purpose user control to avoid having to force our
users to use complicated shortcodes in order to add items to, say, a pricing table, or – in this case –
a list of product features. This user control can be used for adding, removing and sorting items, and
its use should be self-explanatory.

To show or edit an item's details, click on the small arrow on the right. Each feature item consists
of a title, an image/icon URL and a text field. You can add as many items as you need. If you leave
the Image URL field empty, a default icon (tick in a circle) will be used instead. 

Use the List of Features block as if it were a list of bullet points. Outline your features and benefits,
something like "Text your friends for free – Save a lot of money by using instant messaging", which
combines a feature with a benefit.

You can edit the existing items, delete some or add more. Just make sure that you save your 
settings.

Payment Options

It's time to edit the Payment Options block. Just activate the Payment Options tab. The familiar
Headline and Sub Headline are available here as well, followed by a list of Payment Methods. Each
payment method you tick there will show an icon on your landing page. 

The action buttons  you defined earlier  will  also be displayed prominently  above the payment
method icons.



Your First Results

And that's basically it! You should now have a basic landing page to look at. If you haven't imported
the demo data earlier and created your own WordPress landing page instead, go to Pages → All
Pages and select "View" from the hover menu for the page you created.

Of course, at this stage your landing page is just a starting point. There are many more features to
discover, and a variety of blocks to help you add content to your landing page. Most blocks follow
the principles you have seen so far: a headline, a sub headline and a user control to add, remove
and sort items. Some landing page blocks have additional options, some only consist of a text field.
In general, however, you will find that they are very easy to use and their options self-explanatory. 

If not, a quick look at the manual should help you uncover any secrets. Make sure you read up on
the  import/export  features  and  profiles  to  find  out  how  to  preserve  previous  settings  and
experiment with the different options without losing your work.

3 General Settings
3.1 Menus

JustLanded for WordPress supports two menus, one at the very top, and one at the bottom. The
main menu bar at the top can be hidden on landing pages, the utility or footer menu is always
visible when defined. Both menus are native WordPress menus and can be edited easily.

Top Menu

In order to change the contents of the top menu bar, go to Appearance → Menus and select a
WordPress menu as your Main Menu under "Theme Locations".

If you would like to hide the menu bar from your landing page, click on the paper plane icon to
launch the JustLanded for WordPress user interface, activate the "General Settings" and finally
uncheck the "Show site menu on landing page?" option.

Footer Menu

If you would like to change fonts, colors, background images etc., you can do so via Fonts and Colors → 
Colors (for colors and background images) and Fonts and Colors → General Fonts/Landing Page Fonts for all 
fonts affecting the banner.

If you would like to change fonts, colors, background images etc., you can do so via Fonts and Colors → 
Colors (for colors and background images) and Fonts and Colors → General Fonts/Landing Page Fonts for all 
fonts affecting the banner.



You can use the footer menu to show links to your privacy policy or contact form. In order to
change the contents of this menu, go to Appearance → Menus and select a WordPress menu as
your Footer Menu under "Theme Locations".

3.2 Customization

Show site menu on landing page?

By checking or unchecking this option you can control  whether or not the site's menu will  be
displayed above the header section.

Always hide menu?

If this option is active, the menu will be hidden permanently.

Use 'sticky' menu?

This option 'sticks' the menu to the top. That way the menu will always be positioned at the top
while the user scrolls through the page content.

Custom Main Menu

This overrides the WordPress Main Menu menu allocation for this profile. That option only works if
a default Menu is defined for the Main Menu location under Appearance → Menus.

A  separate  option  exists  to  define  a  menu  displayed  when users  are  logged in.  This  may  be
interesting for membership sites.

Custom Footer Menu

This overrides the WordPress Footer Menu menu allocation for this profile. That option only works
if a default Menu is defined for the Footer Menu location under Appearance → Menus.

A separate option exists to define a menu displayed when users are logged in. 



Custom Logo 

The logo will be shown next to the site title. In our default version it is the JustLanded logo, a small
paper plane icon.

You can upload your own logo or remove the logo entirely through the "Custom Logo" section
inside the "General Settings" tab. Simply click "Remove" and save your settings in order to remove
the logo, or use the Upload button in order to upload a custom logo.

The  logo  will  not  be  resized  by  default,  so  make  sure  the  logo  you  upload  has  the  correct
dimensions. The default logo width is 40 x 35 pixels in size. Any logo with a height of 35 pixels
should work best. 

If you would like to use a larger logo graphic, we recommend that you use the "Hide page title and
tagline" option to replace those items with a logo-only header.

Hide main site/page title and tagline?

This option enables you to hide page title and tagline. This is useful if your intention is to use a
large logo instead of a text headline here.

Custom Favicon

A favicon is  a file  containing a small  icon,  most commonly 16×16 pixels,  associated with your
website. You can upload a custom favicon using the "Favicon" section of the "General Settings" tab.
If would rather not upload your own icon you may decide to remove the icon altogether. Just click
on "Remove" and save your settings in order to remove the favicon.



Blog/Index Page Title

This is the title shown on your blog or index page. By default it simply says "Blog", but you may set 
it to anything you like. This option is available through the "General Settings" tab.

Always show full post?

By default JustLanded for WordPress shows only excerpts on post index pages. By checking this
option, the full posts will be displayed. This makes in-line content such as images and video clips
included in a blog post visible.

Hide Post Meta Info?

Check this option to hide the date and time the blog post was published.

Hide Post author Info?

Check this option to hide the author's display name and the link pointing to the author archive.

Hide Featured Images?

By default JustLanded for WordPress displays images set as "Featured Image" as a banner above
the post's headline. If you would like to hide these images, check this option.

Site Footer/Copyright Notice

You can add a custom copyright notice here to replace the default text on the site's footer.

Footer Widgets

You can define the amount of widgets to display in widget rows and the footer widgets section and
also opt to display the footer widgets section on all pages, including landing page (experimental 
option).



Header Section

Header Contact Information

When entered, either a phone number or an email address can be displayed and linked to in your
site's header. If all fields are left empty, this block will be hidden.

Custom Header



If for whatever reason the header section does not meet your requirements, or if support directs
you to do so, you can replace the entire header section with your custom code. You may either
simply enter your HTML source here, and mix it with shortcodes – or you can select a WordPress
page to retrieve content from. This page may be set to "private" as it does not have to be visible in
order for JustLanded for WordPress to retrieve content from it.

The Custom Header feature is for advanced users and overrides the default template, so whatever you design 
here will look very different from the default template. You may have to apply your own styling via 
General Settings → Custom Codes → Custom CSS.

The Custom Header feature is for advanced users and overrides the default template, so whatever you design 
here will look very different from the default template. You may have to apply your own styling via 
General Settings → Custom Codes → Custom CSS.



Built-in Features

You can optionally deactivate some features, if you don't need them. This might also be helpful if
you are using alternative scripts to replace some of the built-in features.

Activate lightbox for all links pointing to images?

If this option is active, the theme will attach the lightbox to all images linking to an image. This will
enable the lightbox for your posts and pages.

Activate lightbox for Gallery block?

This option activates the lightbox for the gallery block. If this option is not active, thumbnails will
link to the large version of the image.

Activate scroll up link?

This option activates the “Scroll up” link located at the very bottom of each page. This is a usability
feature that lets your visitors jump to the very top of the page without scrolling.



Custom Codes

Custom CSS

Any custom CSS blocks entered here will  be added to the site's header. This enables extensive
customization of JustLanded for WordPress without changing the original theme. 

As settings are not overwritten during a theme upgrade, neither will be custom CSS instructions.

Custom Footer Scripts

Custom  scripts  entered  here  will  be  added  to  the  site's  code.  <script></script>  tags  must  be
included.

Custom Header Scripts

Some scripts must be placed in a page's header rather than the footer section. Post those scripts
here. And, again, <script></script> tags must be included.

Global Custom Styles and Scripts

The same instructions as for the above Custom CSS/Scripts blocks apply, except that settings made
in  the  "Global"  section  will  be  used  throughout  all  profiles.  This  may  be  useful  for  site-wide
tracking etc.



Colors

In JustLanded you can customize most colors the theme uses. You may wish to start with a preset.
Simply activate the "Fonts and Colors" tab to see available presets and themes. When you click on
a preset to start  the import process, the user interface will  prompt you to verify your choice.
Loading a preset will overwrite all changes you made to the Fonts & Colors sections, so make sure
you have a backup of your customizations before proceeding.

Font colors are defined together with font face and font size under "General Fonts", "Landing Page
Fonts" and "Blog Fonts", but all remaining colors can be found in the "Colors" section under "Fonts
and Colors". Click on the color picker icon to select a color, or enter the color code manually in the
text field next to the color picker icon.

You can change the banner's background image and gradient via Fonts and Colors → Colors → Landing Page 
Banner and Page Banner. Select “Background Image” as Banner Background Type and upload your image 
under “Banner Background Image”.

You can change the banner's background image and gradient via Fonts and Colors → Colors → Landing Page 
Banner and Page Banner. Select “Background Image” as Banner Background Type and upload your image 
under “Banner Background Image”.



Custom Button Colors

In version 1.2.0 you have two options for customizing buttons. You can either select a base color
from which the theme will calculate the remaining colors (only based on the hue value), or you can
opt to define every single color yourself.

Please note that the "Overwrite default button style with custom style settings?" checkbox needs
to be checked in order for your changes to apply, no matter which of the two options you use.



Presets

We provide presets to give you a great starting point. You can select a preset from the Fonts and
Colors → Presets tab. Clicking on a preset and proceeding to import its settings will overwrite all
existing font and color customizations made to the active settings profile.

Fonts

For most fonts you can select the font size (and its unit), the font face,  a font style and a font color.

The first fonts listed are standard font families such as Arial and Verdana. They are marked with an
asterisk ("*") and have the least impact on performance as they do not require web fonts to be
loaded with your landing page. By default we use these fonts as body fonts only.
The only font styles available for these fonts are regular, bold, italic and bold italic.

Google Web Fonts are available for selection as well. If you a select a Google Web Font, the Font
Style select box will show all styles available for that font. By default the 'regular' style is active, but
for headlines it will often make sense to select another style.

Clicking on the color picker icon will enable you to select a color for that font. You may also choose
to enter a hex color yourself into the text field next to the color picker icon.

4 Landing Page
4.1 General

Landing Pages use a special template ('Landing Page') that enables them to display unique landing
page blocks defined through the options panel.

If you would like to make any landing page your front page or change your blog index page, please refer to 
http://codex.wordpress.org/Creating_a_Static_Front_Page  for instructions how to do this with WordPress.
If you would like to make any landing page your front page or change your blog index page, please refer to 
http://codex.wordpress.org/Creating_a_Static_Front_Page  for instructions how to do this with WordPress.

http://codex.wordpress.org/Creating_a_Static_Front_Page
http://codex.wordpress.org/Creating_a_Static_Front_Page


4.2 Layout Blocks

The concept of JustLanded makes it possible to create an entire landing page simply by adding,
arranging and editing pre-defined content blocks.  No design knowledge is  necessary at  all,  no
coding – everything is done within the JustLanded for WordPress user interface.

You  can  enable  and  disable  landing  page  blocks  under  the  "Landing  Layout"  tab.  Launch  the
JustLanded for  WordPress user interface by clicking on the paper  plane icon and activate  the
"Landing Layout" tab to access this feature. 

Activation & Deactivation

You can enable or disable landing page blocks by dragging them to the "Enabled" or "Disabled"
sections. 

The Banner block is always visible as it is an integral part of the landing page. In theory you could
set up a landing page with just the banner block, as the banner also includes the main action
buttons. In this case, the "Enabled" section would be empty, but the banner would still be visible.

Block Order

To change the position of any landing page block, simply drag the block to the desired position.



4.3 Banner

Banner Layout

The Banner Layout select buttons allow you to define where you want to show media and text
content. By default, media content is shown on the right and text content on the left.

You can optionally select to hide the banner.

Text Content

Banner Title

The banner title is the main headline shown above any text content.

You can break the headline into multiple lines by inserting a line break at the position where you
want the following text to move to the next line. Simply type your text on two lines in the text box
and that will be mirrored on the landing page.

Banner Text

This is a free text field. You can enter text as you like, and line breaks are translated.

Banner Bullet Points

Enter one bullet point per line. Bullet points will automatically be styled with a tick icon and shown
in bold.



Custom Text Content

If for whatever reason you would like to use your own content for the text section, please feel free
to do so using the "Custom Text Content" field, or by selecting a WordPress page from which you
want the theme to retrieve content.

Call To Action Options

You can optionally hide the action buttons  and/or show a sign-up form in place of the action
buttons.

You also have the option to replace action buttons with a newsletter sign-up form that will be
displayed in their stead.



Media Content

You can display 3 different media types in your banner's media section: a single image, a rotating
image slider, or a video clip. The "Select Media Content" select box allows you to select which
content type you would like to be shown. You can define all 3 content types and switch between
them as contents will be preserved.

Alternatively,  you can opt to integrate your own media type via the Free Form Media Content
option.  This  option  enables  you  to  include  custom  video  integration  codes,  experiment  with
custom slider plug-ins by using their shortcode etc.

Single Image

Use the "Upload" button in order to upload a new image. You may also choose to enter a URL into
the text field. Clicking on the "Remove" button empties the text box and removes the image.



Slider

You can add as many images as you want to be displayed. Add new slides using the "Add New
Slide" button, and remove a slide by unfolding it (arrow down icon) and then clicking on the red
"X" button.

Each slide has a title which will also be used as the image's description (ALT tag), and an optional
link to be associated with that slide.

Video

JustLanded for WordPress supports oEmbed links in this section. Simply paste your video link here
and WordPress' own oEmbed filter will turn it into a video embed code. 

You can find more information on how to obtain the embed link here:

http://support.google.com/youtube/bin/answer.py?hl=en&answer=171780

http://vimeo.com/help/faq/embedding

http://vimeo.com/help/faq/embedding
http://support.google.com/youtube/bin/answer.py?hl=en&answer=171780


When using the oEmbed method, please keep in mind that you need to provide the actual video
URL, not an embed or 'share' URL. Simply copy the URL from your browser's address bar and you
should be fine.

For backwards compatibility the theme also accepts video integration codes here, using iframes,
embed or object codes. 

If you are still using one of those, please change to the new oEmbed links as only those are fully
responsive and ensure that your videos will look just as awesome on mobile devices as they do on
desktops.

Also, in case you are still using this field for custom HTML content, please switch to the "Free Form
Content" type instead.

Free Form Content

If  this option is selected under "Select Media Content", the contents of the "Free Form Media
Content" box replace the entire media section. HTML and shortcodes are allowed.

This enables you to use third party sliders, embed exotic videos, Java-Applets, plug-in content, etc.

NoteNote

If you intend to use forms in the banner, please refer to the separate tutorial in the /Documentation/Forms 
folder of the main package.

The tutorial contains instructions on how to replicate our form demos, as well as some custom code to 
beautify your forms.

If you intend to use forms in the banner, please refer to the separate tutorial in the /Documentation/Forms 
folder of the main package.

The tutorial contains instructions on how to replicate our form demos, as well as some custom code to 
beautify your forms.



Full Width Banner Content 

This option enables you to define the entire banner yourself using shortcodes, plug-in content,
custom HTML, etc.

You may also choose to display the contents of a WordPress page in the banner using the "Use
Page Content" option. If a page is selected, the content in the text box above will be ignored.



4.4 Page Banner (experimental)

When the “Default Template, with Page Banner” template is used, the Banner → Page Banner
options can be used to define a banner section that replaces the page title.

For this Page Banner JustLanded comes with an additional shortcode, [justlanded_pagetitle], which
outputs the current page's title in the banner.

You can also select a (private) WordPress page from which to retrieve the content to display in your
Page Banner.

This section also accepts HTML and some of the theme's shortcodes.

4.5 Action Buttons

The action buttons contain your "call to action" (CTA), and will likely provide an option to buy your
product, sign up for a mailing list, or download a free sample.

Styles

You have the choice between two default styles: a split button, consisting of two buttons or a
single big button. 

Please  note  that  in  version  1.2.0+ you can also  style  the action buttons  with your  own color
options, via the Fonts and Colors → Colors menu.

NoteNote



Links and Captions

You can point either one of the two buttons to any URL you like. You also have the option to open a
link in a new window.

If desired you can also set an "OnClick" attribute for the link. This may be useful for tracking.

If the "Single Large Button" style is used, settings for the second button will be ignored.

Modal Windows (experimental)

Since version 1.2.0 JustLanded for WordPress supports modal windows that can be triggered by
one or both of the call to action buttons.  You can define the content through the text area field, or
by selecting a WordPress page that should be used instead.

Modal windows are like pop-up windows, except that they are less intrusive and open in the same
browser window on top of a black overlay. Clicking outside the window closes the modal window,
as does clicking on the "X" symbol.

4.6 Social Icons



JustLanded for WordPress can display social network links as part of the header ("Header Social
Icons"), and in a dedicated floating sidebar ("Sidebar Social Icons").

Activation & Deactivation

You can drag and drop icons that you would like to display into the "Enabled" section. If no icons
are enabled for either the header or the sidebar, that section will be hidden.

Social Profile Links

You  need  to  associate  a  profile  link  with  each  icon.  Simply  enter  a  fully-qualified  URL  like
http://www.twitter.com/shapingrain for each service.

4.7 Feature List

You can set a headline and a sub headline to be shown above the list of features. Each feature item
consists of a title and a descriptive text. Optionally, an icon can be uploaded as well.

Add, edit, re-order and delete features

You can add new items using the "Add New Feature" button, and remove items by unfolding them
and clicking the red "X" button. 

You can re-order items by dragging them to a new position. Re-ordering works best when items are
folded.

Title
The title will be displayed above the description.

Image URL
You can either enter a fully-qualified URL, or upload a picture here. The default icon size is 60 x 60
pixels.

Link URL
You can link an item's headline by entering a fully-qualified URL here.



Description/Text
The description goes underneath the title and provides room for more details.

4.8 Gallery

You can set a headline and a sub headline to be shown above the gallery. Each gallery item consists
of a title, the image to be displayed, and a description text. 

Add, edit, re-order and delete images

You can add new items using the "Add New Image" button, and remove items by unfolding them
and clicking the red "X" button. 

You can re-order items by dragging them to a new position. Re-ordering works best when items are
folded.

Title
The title will be displayed above the description.

Image URL
You can either enter a fully-qualified URL, or upload a picture here. Thumbnails will be generated
automatically, and resized to 140 x 95 pixels.

Description/Text
The description will be used as the image's title tag. It will be displayed underneath the image in
the lightbox.

4.9 Testimonials

Featured Testimonial

The featured testimonial's purpose is to highlight an important quote. It contains additional fields
for a name and a job title or company name.

This block is also available as a slider that retrieves testimonials from the "Small  Testimonials"
block of the active profile.



Small Testimonials

You can display an unlimited amount of small testimonials. They contain fields to enter a name, a
job title or company title and the quote/text itself. In addition, small testimonials can also contain
a small portrait picture. 

Add, edit, re-order and delete items

You can add new items using the "Add New Image" button, and remove items by unfolding them
and clicking the red "X" button. 

You can re-order items by dragging them to a new position. Re-ordering works best when items are
folded.

Name
This is the field reserved for the name of the person you are quoting.

Sub Title/Company/Profession
This field contains that person's job title or a company name. It will be shown underneath the
quote.

Image URL
You can either enter a fully-qualified URL, or upload a picture here. Default size is 60 x 60 pixels.
CSS rules will be applied to make the image appear round.

Description/Text
This is the actual quote.

4.10 Newsletter

Headline



The newsletter sign-up form features a "headline", which will be displayed on the form itself.

Subscribe Button Text

This is the "Subscribe" button's caption. In most cases it will simply say "Subscribe".

Email Text Field Placeholder

This placeholder will be displayed while the email form field is empty.

Service Selection

JustLanded integrates with AWeber or MailChimp. However, since any provider should work with
the built-in sign-up form that supports sign-ups through external HTML forms, other services may
be supported through ShapingRain support.

Choose between "AWeber", "MailChimp" or "Custom Integration" by clicking on the service icon. 

Service Settings

Check one of the "Show... Settings" checkboxes, depending on the service of your choice. You may
enter settings for all supported services, but only those for the activated service will be used.

Retrieve your integration code from your service provider and edit the form fields to match that
code. In many cases,  only  the Post  URL and Form ID fields will  be necessary in order for  the
integration to work.



MailChimp

Generate your code using the MailChimp interface. Head to "Lists" and click on the list you would
like to obtain the code for. Then click on “Signup forms” → “Embedded Forms” → “Super Slim”.

This form will only work if "email address" is the only required field. Keep this selection and scroll
down to the "copy/paste into your site" section.

This code contains one line similar to this:

<form action="http://abcdefg.us2.list-manage.com/subscribe/post?
u=3c8f7015ad03ee5404b8ca274&amp;id=01ecce1c9b" method="post" 
id="mc-embedded-subscribe-form" name="mc-embedded-subscribe-form" 
class="validate" target="_blank" novalidate>

Extract the following parameters and enter them into the JustLanded user interface:

Post URL:   http://abcdefg.us2.list-manage.com/subscribe/post?
u=3c8f7015ad03ee5404b8ca274&amp;id=01ecce1c9b

(everything between »action="« and the following »"«.

u parameter:   3c8f7015ad03ee5404b8ca274

id parameter:  01ecce1c9b



AWeber

Create a  new HTML  form in AWeber using the form builder.  It is sufficient to generate  a  'blank
form'  without  styling.  You  can  identify  the  individual  form  fields  by  looking  at  the  "name"
attributes.  The  "value"  attribute  contains  the  value  you  need  to  copy  into  the  JustLanded
Newsletter settings.

The form action="..." parameter is your Post URL.

Contact support if you need any assistance. If you are requesting assistance from our support,
please always forward the original integration code you received from or generated through your
service provider, or provide us with your account data so we can generate the code on your behalf.

Custom Integration

Through the Custom Integration Code section ShapingRain.com support will be able to help you
integrate pretty much any third party mailing list service that supports sign-ups from remote sites
via POST form submissions. 

This code will also contain the actual form field. In essence, the form code used here will have to
be stripped of all tags except for the <FORM> and <INPUT> tags. The email address field must have
a class 'email' and the submit button must have the classes 'submit gradient'.

Please contact support if you need to integrate a service we do not currently support, as we may
be interested in making this integration available to all our customers through an upgrade, and if
you have no experience with HTML and CSS, you may save time if customer support makes the
necessary changes on your behalf.

If you contact support, please send a copy of the original HTML code provided by your mailing
list service. If you do not provide that code in your email, we will request that information from
you.

4.11 Pricing Table



The pricing table features a headline and a sub headline. In addition, the buy button's caption can
be freely customized. The currency symbol can also be chosen freely.

Add, edit, re-order and delete packages

Title
This is a package's main title. It should be short and catchy as there is little space.

Sub Title
This is the sub title, it can further describe a package or its intended target group.

Link URL
This is where the buy button will link to. Please note: If no link is entered, the call to action button
for this table item will be hidden.

Description/Text
Use this field to further describe a package with its features. Enter one feature per line.

Price
This is the price. Do not enter a currency sign or symbol here as it will be added from the pricing
table's global settings.

Badge
You can highlight a package using one of the pre-defined badges. If a badge is selected, it will be
shown in the top right corner.



Highlighted/Featured
If you select "Yes", the package will be highlighted. You can have multiple highlighted packages per
pricing table.

4.12 Payment Options

The  Payment  Options  block,  which  is  usually  the  last  content  block  used  on  a  landing  page,
features a headline as well as a sub headline. Action buttons are part of this block as well, they can
be defined using the "Action Buttons" tab.

Accepted Payment Methods can be selected. For each selected payment method, an icon will be
shown on the landing page.

4.13 Widgets Row

You can use the Landing Layout tab to position up to two rows of  widgets anywhere on your
landing page. Both widget areas can be filled with content (widgets) through the Appearance →
Widgets menu, just like a regular widget area.

Widgets will be displayed in a row, and they will collapse and appear stacked on mobile devices.
JustLanded widgets (testimonials, recent posts and comments, sign-up form) are fully supported.

You can select how many columns the Widgets Row should have via General Settings → Advanced Settings 
→  Widgets → Amount of columns for Widgets Row and Footer Widgets.
You can select how many columns the Widgets Row should have via General Settings → Advanced Settings 
→  Widgets → Amount of columns for Widgets Row and Footer Widgets.



4.14 Blog Posts

You can also add blog content to any of your landing pages by using the "Blog Posts" landing page
block. This block comes with its own sidebar area and resembles the regular post index page.

This landing page block is particularly useful for users who wish to use JustLanded not for a typical
landing page, but rather for a regular blog.

Advanced options to customize the output of this block can be accessed via the JustLanded options
panel.  The "Blog  Posts  on  Landing Pages"  section is  part  of  the General  Settings  → Blog and
Archive tab.

4.15 Other Advanced Content Options

JustLanded comes with more options  to include complex content on your landing pages,  with
"Page Content" blocks being the most popular option.



Page Content

Page Content blocks can contain free content. They also parse shortcodes so that third party plug-
ins can be integrated this way.  

Page Content blocks retrieve content from WordPress pages, and content can be edited by editing
the corresponding page using the WordPress page editor.

A maximum of four Page Content blocks can be defined per landing page.

Section Layout

One Page Content block can show content from a single WordPress page, but it can also retrieve
contents from two WordPress pages and show them in two columns.

If "Full Width" is selected, a page defined as "Source 2" will be ignored.

Show Page Title

If this checkbox is checked, the WordPress page's title will be displayed. If it is unchecked, only the
contents of that WordPress page will be displayed.

Do not wrap block in extra section

You will  likely not  want to use  this  option,  unless you are putting landing page blocks  within
landing page blocks.

By  selecting  this  option  you  instruct  the  theme  not  to  wrap  the  Page  Content  Block  in  a  
<div class="row"> and a <section> block. This will prevent some display issues when using Landing
Page Blocks within Page Content Blocks (which are in itself Landing Page Blocks). When this option
is active, the title will not be displayed (as it would be part of the wrapper), no matter whether the
title is hidden or not.

The Page Content block is the only option to add custom, free-form content to your landing pages.
If you need to integrate content generated by a third-party plug-in through a shortcode, or any custom HTML 
code, this is the block to use. It retrieves its content from any WordPress page (published as 'private' to avoid 
indexing).

The Page Content block is the only option to add custom, free-form content to your landing pages.
If you need to integrate content generated by a third-party plug-in through a shortcode, or any custom HTML 
code, this is the block to use. It retrieves its content from any WordPress page (published as 'private' to avoid 
indexing).



Source 1 and Source 2

You can define any WordPress page as Source 1 or Source 2. It might be a good idea to set a page's
status to "private", as that will hide the page from the menu.

Landing Page Widgets (Widget 1 & 2)

Landing Page Widgets (full-width widgets) are an experimental feature. A widget's contents will be
shown wherever the "Widget 1" or "Widget 2" blocks are dragged to. This enables you to use full-
width widgets for the integration of third party applications.

ShapingRain.com support may also provide you with modifications that use this content block type
to integrate special features. 

You can set the contents of that widget area using WordPress' Appearance → Widgets menu.

5 Blog and Static Pages
5.1 Page Templates

We provide 3 template types for WordPress pages:

Landing Page
Any page that uses the Landing Page template will be displayed as a landing page with banner.
Typically you will have exactly one landing page. However, with Profiles you may be able to use up
to 9 different landing pages with one instance of WordPress.

Landing Page (no banner)
This is a legacy template that we ship for compatibility only. We recommend that you do not use
this template anymore since it has been replaced by a 'hide banner' option.

Default Template
This is the default page template, full-size without a sidebar.

Default Template, with Page Banner
This is the default page template, but with a 'page banner', a custom banner that can be defined
through the options panel. This template does not use page titles, but a shortcode can be used to
display the page title within the banner.

Page, with Sidebar
This is a modification of the default template. The only difference is that it includes a sidebar.

If you do not want the 'Comments' form to display on your pages, just deactivate them for pages where you 
don't want them. http://codex.wordpress.org/Comments_in_WordPress explains how this WordPress feature 
works.

If you do not want the 'Comments' form to display on your pages, just deactivate them for pages where you 
don't want them. http://codex.wordpress.org/Comments_in_WordPress explains how this WordPress feature 
works.

http://codex.wordpress.org/Comments_in_WordPress
http://codex.wordpress.org/Comments_in_WordPress


Page, with Sidebar on the left 
This is a modification of the 'Page, with Sidebar' template, but with a sidebar on the left hand side.

5.2 Shortcodes

Layout Blocks

We provide shortcodes for layout blocks, to enable the use of column layouts:

[one_half last="no"][/one_half]
[one_third last="no"][/one_third]
[two_thirds last="no"][/two_thirds]
[three_fourths last="no"][/three_fourths]
[one_fourth last="no"][/one_fourth]

The  optional  parameter  "last"  defines  whether  this  is  the  last  column  in  a  row.  
You would define a row like this:

[three_fourths last="no"]
This column has a width of ¾.
[/three_fourths]
[one_fourth last="yes"]
This column has a width of ¼.
[/one_fourth]

Buttons for quick access are provided through the TinyMCE editor interface via the paper plane
icon.



List Styles

We provide different list styles with JustLanded for WordPress. In order to turn a regular bullet list
(unordered list) into a styled one you have to wrap your list with one of the following shortcodes:

[list style="check"][/list]

[list style="plus"][/list]

[list style="star"][/list]

[list style="caution"][/list]

[list style="info"][/list]

[list style="heart"][/list]

[list style="calendar"][/list]

[list style="pin"][/list]

[list style="arrow"][/list]

[list style="delete"][/list]

An example might look like this:

[list style="check"]

• This is a bullet point

• This is another one

[/list]

You basically add a [list ...] wrapper around an existing bullet list. So remember to create the bullet
list first, and then wrap it in a [list] container.

And again, buttons for quick access are provided through the TinyMCE editor interface via the
paper plane icon.



Call To Action Button (experimental)

You can insert a single call to action button using an otherwise
unavailable landing page block:

[landing_block_custom type="button" caption="Buy now" 
link="http://www.shapingrain.com" target="_blank" align="center"]

A variant of this block exists in a 'plain' version without section wrappers. This might work in places
where the first version does not.

[landing_block_custom type="button_embed" caption="Buy now" 
link="http://www.shapingrain.com" target="_blank" align="center"]

Landing Page Blocks (experimental)

You can add any landing page block to a regular blog post or page. We have made improvements
to this feature, but we still consider it experimental. Landing page blocks may look different when
used on regular WordPress pages, and most of these shortcodes are designed for full-width pages
only, which is why they will not look as expected on pages that use the sidebar.

[landing_block type="type_goes_here"]

The following block types are currently supported:

features

gallery

newsletter

big_testimonial

small_testimonials

payment

pricing_table

page_content1

page_content2

page_content3

page_content4

widget1

widget2

You may, for instance, include the newsletter sign-up form using the following shortcode:

http://www.shapingrain.com/
http://www.shapingrain.com/


[landing_block type="newsletter"]

At this  time,  settings will  be retrieved from the settings  profile  marked as Site Default  Profile
(Home → Profiles → Site Default Profile).

We provide only limited support for this experimental feature while we are developing custom
landing page blocks. However, your feedback is welcome, and we will do what we can to help you
use it on your live site, if no extensive additional work is required.

Quick access buttons are provided through the TinyMCE editor.

Custom Landing Page Blocks (experimental)

Like the regular landing page blocks, this feature is still in development.  It enables you to create
most landing page blocks using shortcodes only, without using the interface. That way you can use
multiple instances of the same block to, say, use two newsletter blocks or multiple pricing tables
on one page.

You can mix custom landing page blocks with regular (interface-defined) landing page blocks.

The syntax usually follows this structure:
[landing_block_custom type="pricing_table" title="My Title" subtitle="A Subtitle"
currency="$"]

[item  title="Package  1"  subtitle="My  subtitle"  link="http://www.google.com"
description="Line  1\nLine  2\nLine  3"  price="199"  badge=""  highlighted="no"
button="Buy Me"]

[item  title="Package  2"  subtitle="My  subtitle"  link="http://www.google.com"
description="Line  1\nLine  2\nLine  3"  price="299"  badge=""  highlighted="no"
button="Buy Me"]

[/landing_block_custom] 

We provide a basic code generator ("Custom Block Generator") via the TinyMCE editor. 



Custom Landing Page Content using the 'Parse Content' option (experimental)

Most users will want to use either the pre-defined content blocks via 'Landing Layout' only. 

With that, the preferred way of adding free-form content, such as additional forms, text, images,
column layouts etc. is to use Page Content blocks.

In some cases, however, that may not be enough. Power users wish to obtain total freedom of
what to add where, and for those we have a feature that instructs the theme to obtain landing
page content (except for the banner section) from the landing page's actual page content only.

That way users can mix user interface defined landing page blocks with custom landing page blocks
and free-form content, making it possible to create very long and complex landing pages, and also
to repeat blocks as needed.

When the 'Parse Content' option is checked, you will have to define the landing page's layout and
its contents through shortcodes. This may look like this:

[content_block]

[one_half]

This is some text.

[/one_half]

[one_half last="yes"]

This one's even got a second column!



[/one_half]

[/content_block]

[landing_block type="newsletter"]

[content_block]

This is some more text.

[/content_block]

Note that custom text is embedded using the [content_block] shortcode that has no parameters.
You simply wrap your free-form content in [content_block] blocks. This is absolutely necessary, as
without this wrapper the theme will have no instructions as to how content should be formatted.

You  can  also  use  shortcodes  within  [content_block]  blocks,  but  you  should  not  include
[landing_block] or [landing_block_custom] shortcodes in that wrapped section, as that would not
make any sense since you can add these block shortcodes without a wrapper.

5.3 Widgets

For  your  convenience  we  provide  three  minimalistic  widgets  that  ship  with  JustLanded  for
WordPress. These are designed to fit in with the rest of the design and are used on our demo set-
ups as well:

Recent Posts

The JustLanded Recent  Posts  widget  displays  miniature  versions  of  a  post's  "Featured Image",
when used (60 x 60 pixels).

Recent Comments

The  JustLanded  Recent  Comments  widget  shows  a  user's  avatar  (60  x  60  pixels)  next  to  the
author's name and post title.

Testimonials

The JustLanded Testimonials widget shows testimonials from the "Small Testimonials" landing page
block, without the portrait photograph. They will be retrieved from the settings profile set as Site 
Default Profile (Home → Profiles → Site Default Profile).

Testimonials Slider

This looks just like the regular widget, except that it displays only one widget at a time and works 
as a slider, drawing testimonials from the "Small Testimonials" landing page block using the Default
Site Profile as a data source.



Sign-Up Form

This widget displays a lead capture/sign-up form. It uses the "Newsletter" tab's settings for the Site
Default Profile.

6 Home Menu
6.1 Profiles

Profiles are instances of JustLanded for WordPress settings. You can save different versions of your
settings with customizations and varying content using this feature. 

In order to edit another profile, use the Profile select box at the very top of the JustLanded for
WordPress  user  interface.  Remember  to  save  your  settings  before  you  switch  the  profile,  as
unsaved settings will be lost.

A profile contains all your settings and the contents of your landing page blocks.

You can use the Import/Export option "Transfer Your Settings" to copy settings and customizations
from one profile to another.

Profile selector

Default profiles, to be used 
when no specific profile is selected 

for an individual page.



By default, Profile 1 is the Site Default Profile and will be used for your landing page and the blog.
However, you may choose to select another profile as the Site Default at any time.

Each WordPress page provides you with an option to define a profile associated with that page.
That  way  you  can  have  multiple  landing  pages  that  retrieve  their  contents  from  a  variety  of
profiles.  You  can  use  this  feature  for  split-testing  multiple  versions  of  your  landing  page.  
While intended for use with landing pages, this option is available for all WordPress pages.

6.2 Backup and Import

You  can  create  a  backup  of  the  currently  active  profile's  options  by  clicking  on  the  "Backup
Options" button. The "Restore Options" button will restore the last backup into the currently active
settings profile.

You can transfer your settings between profiles using the Transfer Your Settings option (Home →
Backup and Import → Transfer Your Settings). You may also use this option to create a backup of
your  settings  for  local  storage,  or  to  transfer  settings  from  one  JustLanded  for  WordPress
installation to another.

Simply  copy  and  paste  the  contents  of  the  Transfer  Your  Settings  field  to  the  corresponding
Transfer Your Settings field of another installation and press the "Import Options" button.

7 Free Plug-Ins that ship with JustLanded for WordPress
We provide some free plug-ins for WordPress that integrate with JustLanded for WordPress to
extend its features or to integrate third party services. These plug-ins can be found in the "Plug-
Ins" folder and can be installed like a regular WordPress plug-in.

7.1 WooCommerce Integration

This plug-in integrates the theme's call to action buttons with WooCommerce's shopping cart and
allows users to set up a one-click-to-cart or one-click-to-checkout button for their digital products.
It also fixes some styling issues that are the result of JustLanded and WooCommerce overwriting
each other's settings. The plug-in expects WooCommerce to be installed and at least one product
to be active.  We provide a short tutorial for this plug-in in the Documentation folder along with
this user manual.



7.2 Dynamite for WordPress

This  plug-in  enables  users  to  create  hundreds  of  landing  pages  based  on  one  landing  page
template. It also provides dynamic and conditional content capabilities. Dynamite comes with its
own mini user manual.

7.3 Marketing-friendly YouTube Videos

This tiny plug-in removes the 'recommended' video clips at the end of YouTube videos as well as
the clip's title, when embedding videos in JustLanded.

7.4 Experimental and Developer's Plug-Ins

We also ship some experimental plug-ins with the theme that customer support might ask you to
install in order to achieve a certain result in unusual circumstances. Other plug-ins are developer's
examples to help with the rapid development of plug-ins for JustLanded.

8 Recommended Plug-Ins
We do not believe in re-inventing the wheel. This is why we resisted the urge to add features to
JustLanded  for  WordPress  that  some  well-established  and  highly  specialized  plug-ins  for  the
WordPress platform already provide.



8.1 Contact Form 7

http://wordpress.org/extend/plugins/contact-form-7/

We believe in simplicity, and if all you need is a contact form, Contact Form 7 is the perfect tool,
and an ideal companion for JustLanded for WordPress.  With Contact Form 7 you can create a
contact form using a graphical user interface – and then add it to a WordPress page with a simple
shortcode, or the click of a button.  

JustLanded for WordPress includes all the necessary styling to make your Contact Form 7 forms
look fabulous, out of the box.

If you intend to use forms in the banner, please refer to the separate tutorial in the /Documentation/Forms 
folder of the main package.

The tutorial contains instructions on how to replicate our form demos, as well as some custom code to 
beautify your forms.

If you intend to use forms in the banner, please refer to the separate tutorial in the /Documentation/Forms 
folder of the main package.

The tutorial contains instructions on how to replicate our form demos, as well as some custom code to 
beautify your forms.

http://wordpress.org/extend/plugins/contact-form-7/


8.2 WordPress SEO by Yoast

http://wordpress.org/extend/plugins/wordpress-seo/

SEO still  is  a  major  buzzword,  and something  most  website  owners  cannot  afford  to neglect.
WordPress SEO is the perfect addition to JustLanded for WordPress when it comes to your SEO
needs: post titles and meta descriptions, settings for crawlers/robots, permalink clean-up,  XML
sitemaps, link structure optimization, RSS enhancements – all under one convenient interface.

8.3 W3 Total Cache

http://wordpress.org/extend/plugins/w3-total-cache/

This is one of many caching plug-ins available for WordPress. We recommend it for performance
optimization as it caches the page output and delivers contents statically, thus reducing the time
required to render a page.  We actually use this plug-in on our demo installation for increased
performance.

http://wordpress.org/extend/plugins/w3-total-cache/
http://wordpress.org/extend/plugins/wordpress-seo/


9 Help and Support
9.1 Email Support Policy

Contact Support

If  there is anything we can help you with, please let us know. Whether you have discovered a
problem or need help customizing our product to fit your needs, we are always happy to help out
and point you into the right direction. Simply send an email to support@shapingrain.com.

In order to be able  to provide you with the best  possible service,  we do not  offer  customer
support  through  the  comments  section  on  themeforest and  we  will  direct  you  to  contact
support@shapingrain.com should you seek assistance there.  This ensures that no support tickets
are forgotten and that all  members of the support staff are aware of your issue, resulting in the
fastest and best possible service.

We may occasionally ask you to provide your license certificate on themeforest  to verify your
purchase.

Account Details

If necessary to help you solve a problem we may request that you email us your WordPress login
details and/or provide us with your hosting account details as well in order to identify problems
that are related to your web server environment. Please accept that without those details, we may
not be able to help you in some cases.

Extend of our Support

We generally only provide support for our own product. While we will usually make attempts to
assist you with other issues as well, we will likely have to decline support if the issue exceeds the
scope of our knowledge and experience.

We may also have to direct you to WordPress support for issues related to WordPress itself. While
we may be able to resolve some minor WordPress issues quickly, the experts at WordPress Support
may be better equipped to assist you. However, we will likely attempt to help you ourselves before
referring you to them.

Please accept that we generally do not provide support for other third party products except in
cases where addressing an issue takes only little time.  We recommend that you contact support
and ask if you are unsure whether a particular case is covered by our support policy.

Customization

Most customization requests we receive do not require much time, and we are happy to assist
whenever that is the case. If, however, your request would result in more work, we will have to
restrict our support to giving you basic guidance, or offer you our paid customizations services.

mailto:support@shapingrain.com
mailto:support@shapingrain.com


Customer Account

You can obtain a free customer account from ShapingRain.com through which we provide access
to free updates, pre-release versions, additional tutorials and support options.

Register for free at http://ssl.shapingrain.com/register

9.2 Licenses

Please be aware that the Regular License only covers one end product (website or domain that you
use the theme on). If your intention is to use JustLanded for WordPress on multiple websites, each
site is considered a separate end product and you will have to purchase an additional license.

Please refer to the license text for additional information: http://themeforest.net/licenses/regular 

Some of our premium themes ask you for a License Key. Obtaining and entering this key is optional
and only required if you intend to use the built-in automatic update feature.

9.3 Frequently Asked Questions

JustLanded for WordPress has a Help and Support section that retrieves the FAQ section from our
server every couple of days. You may also refer to our themeforest profile, where we may publish
additional questions and their answers.

9.4 Credits

JustLanded for WordPress is based on the work of generous developers and designers who made
the decision to release their work into the public domain or under open licenses (GPL/MIT).

We would like to express our gratitude to the following projects:

SMOF by Aquagraphite, https://github.com/sy4mil/Options-Framework on which our own options
framework is based.

Zurb's Foundation Framework, mostly for inspiration.

WooThemes for their amazing FlexSlider 2.

Martin Angelov for his TouchTouch gallery.

jQuery for their outstanding JavaScript framework.

Google Web Fonts.

iconSweets by Yummygum.

Premium Pixels.

...and lastly, Automattic and the whole team behind WordPress.

https://github.com/sy4mil/Options-Framework
http://themeforest.net/licenses/regular
http://ssl.shapingrain.com/register


We  would  like  to  thank  our  loyal  customers  for  their  feature  requests,  comments  and
suggestions. In particular we would like to express our gratitude towards the following people:

Sarah of  http://SarahProut.com for her request to add additional widget sections to the theme,
and to support blog posts on landing pages.

Carl,  for  suggesting  that  we  add  optional  modal  windows  to  our  call  to  action  buttons  for
additional flexibility. You can buy his new book Mad About Undead You from Amazon!

Sid, for requesting that we assign unique IDs to each block generated on a landing page to allow
for  custom  styling.  He  was  also  the  first  customer  to  request  that  we  further  develop  the
experimental feature that enables users to add landing page blocks to regular pages. And finally, it
was Sid who inspired us to add a new option to the page editor that instructs the theme to ignore
the 'Landing Layout' section and parse the actual page contents instead.

Brady, for contributing his idea of a full-size banner that could enable the use of a full-size slider or
other content of a user's choice.

Mark, for suggesting that we add a sign-up form to the banner that optionally replaces the sign-up
buttons.

Morgan, for suggesting that we add an additional 'Page Banner' template.

Many  more  feature  requests  and  comments  reached  ShapingRain.com  in  the  last  couple  of
months.  We appreciate  every  single  comment,  and your  valuable  feedback  continues  to  help
making JustLanded for WordPress an even better product.

© 2012 – 2014 ShapingRain.com

http://www.amazon.com/Mad-About-Undead-You-ebook/dp/B009BC52EC
http://SarahProut.com/
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